Release Notes for Nuke and Hiero 11.1v5

Release Date
23 July 2018

Qualified Operating Systems

- macOS Sierra (10.12) or macOS High Sierra (10.13)
- Windows 7 or Windows 10 (64-bit)
- CentOS 6 or CentOS 7 (64-bit)

**NOTE:** If you intend to use floating licenses with Nuke 11.1, you'll need to upgrade the version of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge Base article [Q100320](#) for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

**NVIDIA**

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at [www.nvidia.co.uk/object/cuda_gpus_uk.html](http://www.nvidia.co.uk/object/cuda_gpus_uk.html).

**NOTE:** The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.


• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don’t have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

**NOTE:** We recommend using the latest graphics drivers, where possible, regardless of operating system.

### AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.0Q.1</td>
<td>AMD FirePro W8100</td>
<td>17.0Q.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.0Q.1</td>
<td>AMD FirePro W9100</td>
<td>17.0Q.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3-17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.0Q.1</td>
<td>AMD Radeon RX 480</td>
<td>17.0Q.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3-17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

**NOTE:** Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

### Mac GPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new **Enable multi-GPU support** option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

**NOTE:** To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality. However:
• If you’re running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.
• If you’re running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU acceleration.

New Features

End User License Agreement

This release of Nuke includes a new version of the End User License Agreement (EULA), available here.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

There are no bug fixes in this release.

New Known Issues Specific to this Release

This section covers new known issues and gives workarounds for them, where appropriate.

New Known Issues Specific to Nuke

• BUG ID 346731 - Linux only: Moving Roto shapes with a Wacom tablet installed exhibits lag in the Viewer.

As a workaround, set the QT_COMPRESS_TABLET_EVENTS environment variable to 1 in the current session. For example:

    export QT_COMPRESS_TABLET_EVENTS=1

For legacy versions of Nuke where this variable does not exist, see the Support Portal article here.
• BUG ID 339241 - MatchGrade: Clicking **Analyze Reference Frames** with a Read node with no valid file path displays an **Uncaught C++ exception occurred during the execution of python script!** error.

• BUG ID 316577 - macOS only: Current localization progress does not update if the pointer focus is on Nuke's menu bar.

• BUG ID 312350 - Visual Diagnostics: The **Profile** tab occasionally flickers when the application window is maximized.

• BUG ID 309259 - Documentation: The Python Developers Guide incorrectly references Qt 4.8.5 source code.

For links to the correct source files, see the Nuke Developers page under **Nuke Qt binaries and source files**: [https://www.foundry.com/products/nuke/developers](https://www.foundry.com/products/nuke/developers)

• BUG ID 277875 - VFX Platform: Switching workspace occasionally draws the new workspace incorrectly.

**New Known Issues Specific to Nuke Studio and Hiero**

• BUG ID 314088 - Windows only: The first frame of localized files in the outdated state, colored red, do not always update correctly.

• BUG ID 313849 - Localization: Reading certain multiview .exr files causes Nuke to crash.

As a workaround, rename or move your .nuke folder and re-launch Nuke to refresh the **uistate.ini** file.

• BUG ID 313013 - Timeline Read Nodes: Opening the Node Graph from the Project bin and then returning to the timeline environment behaves as if the left mouse button is held down.

As a workaround, left-click in the timeline to cancel the mouse press.

• BUG ID 310067 - Timeline Read Nodes: Loading large projects is currently slower than expected.

**Other Known Issues**

This section covers legacy known issues and gives workarounds for them, where appropriate.

**Known Issues Specific to Nuke**

AudioRead

• BUG ID 18924 - Changes to the **rate** control value are not honored when **ratesource** is toggled between file and custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.
• BUG ID 18465 - The **time range** control doesn't limit the range when an **endtime** is specified.
• BUG ID 18451 - Flipbooking doesn't honor the time range knob.
• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.
• BUG ID 18213 - Changing **Draw Style** in the Curve Editor or Dope Sheet doesn't redraw the curves correctly.

**BlinkScript/CUDA**

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when the OS wakes up from sleep mode.

    As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

**CameraTracker**

• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez modes.
• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference thumbnails, rather than just the RGB values.

**Deep**

• BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then writes it to disk, causes Nuke to crash.

    As a workaround, run the script from the Script Editor inside Nuke.
• BUG ID 40145 - Nuke occasionally reads and writes Deep **.exr** files with a pixel aspect ratio of 1.

    As a workaround, preview the **.exr** in the file browser before reading it into Nuke.

**Dope Sheet**

• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you execute **Analyze Sequence** with the Dope Sheet open.
• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.
• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from the Dope Sheet.
• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames when **frame snap** is enabled.
• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.
• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to have a non-empty frame expression.
• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.
• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in the Dope Sheet.

EditGeo
• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on geometry with animation baked into its vertices.

To update the transform handle, toggle the axis alignment control between object and average normal.
• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to ignore the EditGeo node.
• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe marker.
• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and corner vertices.

Flipbook
• BUG ID 271435 - Flipbook: Using the flipbook with nuBridge installed causes Nuke to crash.
• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in different output when compared to the Viewer.

As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT in the Flipbook dialog.
• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even if the clip doesn't start at 0.
• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both rec709 and rec1886.

Frame Server
• BUG ID 273472 - Canceling or pausing a comp render in the Background Renders panel displays errors in the terminal.
• BUG ID 272523 - Non-contiguous frame ranges cannot currently be flipbooked.
GPU

- BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke

  
  As a workaround, preserve `sys.argv` in another variable before you import Nuke.
- BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other applications.
- BUG ID 38963 - Calling `import nuke` terminates the Python session if no applicable license is available.

Linux Only

- BUG ID 271807 - Linux only: Adjusting pane or window borders left and right causes redraw lag.
- BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang during start up.

  As a workaround, update your drivers to 361.42.
- BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%, causing Nuke to become unresponsive.
- BUG ID 43766 - Calling `uuid.uuid4()` causes Nuke to crash due to a bug in `libc`.

  As a workaround, launch Nuke from the command-line using:

  ```
  LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0
  ```
- BUG ID 42581 - Keyboard Shortcuts: Using `Ctrl+C` to quit Nuke from the command-line when a dialog box is open displays an error.
- BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

LiveGroups

- BUG ID 274174 - Reloading a LiveGroup currently resets all edited User knobs.
- BUG ID 272281 - Adding a user knob and then undoing the action sets expression links to nodes with matching names in main Node Graph.
Mac OS X Only

- Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers directly from NVIDIA here:

  http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.

- BUG ID 228076 - The PySide QtUiTools library is currently missing from the Nuke build.

- BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to respond.

- BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above, when writing to SMB 2.1 and SMB 3 Sharepoint locations.

- BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the Terminal.

- BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

- BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save Report.

- BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than one instance of Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT 650M.

  As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one instance of Nuke at a time.

- BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default.

  For more information, see http://support.apple.com/kb/HT5293.


  As a workaround, either:
  
  • tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or Samba, depending on source), or
  
  • using the command-line, copy the installation from Mac OS X to the network location using the same file system as the destination.

- BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.

  As a workaround, adjust the Viewer gain control to refresh the Viewer.
• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when Nuke is run from the command-line.

• BUG ID 13638 - The following graphics cards are not currently supported for Mac:
  • ATI Radeon X1600
  • ATI Radeon X1900

  Users with these cards are able to render from the command-line, but in GUI sessions, the Node Graph renders incorrectly due to a requirement of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder

• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a ScanlineRender node causes Nuke to crash.

Monitor Out

• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at the extents of color ranges is incorrect.

  As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB checkbox is enabled and the SDI Configuration is set to Single Link.

• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO

• BUG ID 201193 - Read node Metadata tabs occasionally include irrelevant in and out colorspace controls.

Particles

• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is out-of-date errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off are not reliably cleared when rendering through ScanlineRender.
• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within the particle system.
• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.
• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid lines.

Pixel Analyzer and Scopes
• BUG ID 44176 - PixelAnalyzer: The full frame sampling mode doesn't work immediately in the timeline Viewer when the analyzer is initially added to the layout.
• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the Viewer bounding box to 1x1 for that frame.
• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.
• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color transforms is enabled.

PrmanRender
• In the Nuke camera, the window roll control is not yet mapped to RenderMan.
• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-in the environment.plist file when in GUI mode.


Python
• BUG ID 271373 - A QOpenGLContext::swapBuffers() called with non-exposed window, behavior is undefined error is occasionally printed on the command line.
• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes Nuke to crash.
• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the command-line.

Run the script from Nuke's Script Editor to avoid this issue.
• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.
• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command-line.

To work around this issue, run the Python script from Nuke's Script Editor.
• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports incorrect values.

As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are currently selected in the Node Graph.

• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first created if it has an autolabel.

• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at default (True) may crash when too many node control panels are created too quickly. The workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where NodeClass is the type of node to create) to create the node and then connect it to the currently selected node manually.

• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar item.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:

```
groupName.NodeName.knobname: unexpected 'k' in '0.knobname'
```

The problem is most likely that there is an expression using the input TCL command and doesn't validate that there is an input connected. An example expression:

```
[input parent 0].translate.x
```

The input command returns 0 when it can't find the requested input, which generates an expression of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the value TCL command and specify a default value to return in the case that the expression is invalid. It takes the form:

```
[value [input parent inputnumber].knob defaultvalue]
```

Here is the modified example:

```
[value [input parent 0].translate.x 0]
```

The modified example returns 0 in the event that there is no input 0, and no longer results in an error message.

• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>() if the knob is called 'in'.

For example, this gives a syntax error:

```
nuke.nodes.Shuffle(in = 'depth')
```
while this works because ‘in’ is a string here and not a keyword:

```python
sh = nuke.nodes.Shuffle()
sh['in'].setValue('depth')
```

RayRender

- BUG ID 230256 - Soft Shadows are not currently supported.
- BUG ID 197294 - Reflection occlusion is not currently supported.
- BUG ID 196980 - Clipped alpha shadows are not currently supported.
- BUG ID 196776 - Multiple bounce reflection is not currently supported.
- BUG ID 196124 - RayRender does not currently support refraction.
- BUG ID 195051 - The Wireframe shader node, located in 3D > Shader > Wireframe, is not supported by RayRender.
- BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.
- BUG ID 194819 - RayRender does not currently support Deep workflows.
- BUG ID 191108 - Particle sprites are not currently supported.
- BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported by RayRender.

Read and Write

- BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-line and GUI modes.
- BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file incorrectly.
- BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.
- BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an error decoding frame message in the Comp Viewer.
- BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the rgba channels by default.
- BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
- BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color shifts using QuickTime 10.3 codecs.
- BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444.
- BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes correctly.
• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect while toggling the read transform from file in combination with all objects and/or read on each frame.
• BUG ID 35611 - Writing .exrs with the Write node’s interleave control set to channels adds a superfluous main view.
• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces, leaving gaps in certain circumstances. This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the geometry.
• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.

• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add new views.
• If you have trouble with FBX files, it may be because they were written with an older version of FBX. If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the FBX converter on the Autodesk website. It converts between various different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac OS X, and Linux.

To download the FBX converter:

2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the following:
• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance.
• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.
• If you're using Avid Meridien, you should only write out in NTSC and PAL.
Roto/RotoPaint Open Splines

• BUG ID 42997 - Rendering artifacts can occur if the \textit{feather} control is used in conjunction with the feather handles in the Viewer.
• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and then manually change the Properties \textit{view} control to include both views.
• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.
• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative \textit{feather} values.
• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave erratically.
• BUG ID 42413 - Holding \text{Ctrl/Cmd} to move a point's tangent handles independently causes defects in the hull or feather.
• BUG ID 42412 - Changing the Viewer overlay visibility, such as from \textit{always} to \textit{never}, occasionally produces artifacts in the spline's hull.
• BUG ID 42390 - It is not possible to increase the \textit{width} for individual points if the overall \textit{width} is set to 0.
• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.
• BUG ID 40962 - Animated splines with \textit{varying} width and \textit{feather} occasionally contain slight rendering glitches inside the hull.
• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly from one point to the next
• BUG ID 36219 - The \textbf{Select Feather Points} tool does not work consistently between the \textit{Open Spline} and \textit{Bezier} tools.

Other Roto/RotoPaint Bugs

• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint color.
• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe creation.
• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same shape reverts the shape to its original position.
• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn't extend to the current frame, disappear when drag-selected.

As a workaround, select the shape in the \textit{curves} list to re-display the points.
• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.

**NOTE:** This also applies to SplineWarp matrices.

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don’t work for entries in the curves list.

• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless you follow the instructions below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:
• Click **Save As** to convert the script to the Nuke 8 Roto format, or
• Click **Ignore** to load the Nuke 6 format into Nuke 8. You might select this option if:
  - You don’t intend to make any changes, or
  - You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.

If you want Nuke 8 scripts to load in Nuke 6, use the **convertToNuke6** or **convertDirectoryToNuke6** Python functions when running Nuke 8 in command-line only mode:

**NOTE:** The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6.

• To convert individual .nk scripts:
  ```python
  convertToNuke6(fromScript, toScript, overwrite = False)
  ```

• To convert all .nk scripts in a given directory:
  ```python
  convertDirectoryToNuke6(fromDir, toDir, matchPattern = '*.\nk, overwrite = False)
  ```

**NOTE:** The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command-line (or Terminal):
```
$ <NukeInstallDir>/Nuke8.0v1 -t
>>> import nuke.rotopaint
```

• BUG ID 26855 - The **undo** and **redo** buttons in the Properties panel didn’t work as expected and have been disabled.

The workaround is to use the undo (**Ctrl/Cmd+Z**) and redo (**Ctrl/Cmd+Y**) keyboard shortcuts or the **Edit** menu instead.
• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another frame.
• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.
• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of the screen.
• The foreground onion skin overlay updates as you paint, rather than only updating with the new stroke on pen up.
• It is not currently possible to clone RotoPaint nodes.
• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled on the layer you are working in.

ScanlineRender

• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.
• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi transparent areas.
• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.

SmartVector Toolset

• BUG ID 275683 - SmartVector: Due to VFX Platform library changes, vectors generated by the Nuke 11 SmartVector toolset do not match legacy versions. For example, vectors generated by Nuke 11.0v1 do not match those generated by Nuke 10.5v4.
• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node occasionally displays a spurious No such file or directory error.

As a workaround, scrub to a different frame to remove the message.
• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file browser icon does not open the file browser.

As a workaround, click OK on the error message and then click the file browser icon again.

Text

• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control differently, producing inconsistent output.
• BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer overlay is disabled.
• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does not work as expected.

As a workaround, expression link the translate x and y controls separately.

• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame where the character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting the message field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.

• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

• BUG ID 36372 - Selecting a TCL expression in the message field doesn’t always select the result in the Viewer.

Tracker

• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked frames.

As a workaround, you can enable full frame processing, though this may increase render times.

• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor coordinates to 0,0.

• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.

• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn’t add to the current selection.

• BUG ID 38356 - The zoom window occasionally doesn’t update correctly when scrubbing between frames.

• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available Link to > Tracker linkingdialog or Tracker options.

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to menu.

• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.

As a workaround, keyframe patterns should, where possible, be of comparable sizes.

VFX Platform

• You may experience issues when importing PySide modules into their Python scripts due to the migration from PySide 1.2.2 to PySide 2.0.

In some cases, you can just change calls to:
import Pyside.some_module
to:
try:
    import Pyside.some_module
except:
    import Pyside2.some_module

However, the definition of some classes has moved between modules in PySide 2.0. This particularly affects any Widget related classes, which have been moved from QtGui to QtWidgets, however there are other cases where this may be experienced.

If you experience any problems with this, please refer to the Qt 5.6.1 documentation, or contact support.foundry.com.

• BUG ID 282593 - Switching to a fullscreen workspace on the primary monitor occasionally causes the secondary monitor to turn black.
• BUG ID 280371 - Mac OS X/macOS only: OpenGL errors are printed on the command line when using an ATI Radeon 5770 GPU.
• BUG ID 277548 - A QComboBox with a custom QCompleter currently emits incorrect signals.
• BUG ID 275719 - Mac OS X/macOS only: The Help > About Nuke pop-up is positioned incorrectly on some machines.
• BUG ID 275251 - Mac OS X/macOS only: Hovering over clip instances in the timeline does not change the pointer icon.
• BUG ID 275246/270914 - The terminal or command line displays libpng warning: ICCP: cHRM chunk does not match sRGB on start-up.
• BUG ID 274301 - Node toolbar menu items do not always deselect correctly.
• BUG ID 274264 - CameraTracker results from Nuke 11.1 are not identical to previous versions of Nuke, though the differences are negligible.
• BUG ID 272767 - Launching Nuke from the terminal with the -b argument has been deprecated as a result of library upgrades to comply with the VFX Platform 2017 requirements. There are two workarounds available on Mac and Linux:
  • Run Nuke from the Terminal with & added to the launch command. This allows Nuke to run in the background and returns the command prompt, but closing the Terminal still causes Nuke to close. For example:
    ./Nuke11.1v1 --studio &
  • Run Nuke from the Terminal using the nohup command. This allows Nuke to run in the background and returns the command prompt, but closing the Terminal does not cause Nuke to close. For example:
nohup ./Nuke11.1v1 --studio &

TIP: The nohup command prints output to /Users/<username>/nohup.out or /home/<username>/nohup.out by default, but you can specify a different file by appending > /filepath/filename to the command. For example:

nohup ./Nuke11.1v1 --studio & > /Users/<username>/nuke.out

• BUG ID 272750 - The remove all panels button in the node Properties panel is displayed inconsistently.
• BUG ID 272504 - The timeline Viewer in and out point previews are not working as expected when scrubbing.
• BUG ID 272442/281108 - The Licensing dialog jitters when moved around the screen.
• BUG ID 272338 - The Windows command prompt displays QWidget::paintEngine: Should no longer be called on launch.
• BUG ID 272274 - Closing Nuke Studio does not remove the application icon from the task bar.
• BUG ID 271632 - Nuke prints a libDeckLinkAPI.so error in the terminal on launch.

Warpers

• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display an overlay until pen-up.
• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which cannot be undone.
• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are removed.
• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be undone.
• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to a new layer.
• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the cropped image and the black area between the crop box and the format when merged over a background.
• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines.
• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set at an intermediate value.
• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering problems.
• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in **morph** mode with **mix** set at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather than just the latest, and the keyframes remain on the timeline and in the properties.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

• BUG ID 19079 - SplineWarp: The **C** keyboard shortcut does not currently select the **Add Correspondence Point** tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is not visible in the Viewer.

• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the **Draw Boundary** Viewer button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using **Ctrl/Cmd+A** shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of the Viewer, particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as **default** when you split controls into separate views.

Windows Only

• Nuke Non-commercial: Navigating to **Help > License**, clicking **Deactivate** or **Deauthorize**, and then clicking **Quit**, causes Nuke Non-commercial to crash on exit.

As a workaround, change the **mode** a few times until it works as expected.

• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.

• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you have a previously saved **FileChooser_Favorites.pref** file in your ~/.nuke directory.

As a workaround, move or rename the **FileChooser_Favorites.pref** file, and re-launch Nuke.

• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to **Eraser** mode when you use the erase end of the pen.

• BUG ID 39636 - QuickTime: The **Blackmagic 10 bit (v210)** codec defaults to the **YCbCr 8-bit 422 (2vuy) pixel format** due to a bug in the codec, resulting in solid green frames.

As a workaround, manually set the pixel format to **b64a RGB** to preserve image fidelity.
• BUG ID 35800 - Scopes: The alpha channel doesn’t update correctly when modified through a node, such as Primatte or Shuffle, even after the node is removed from the Node Graph.
• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous
• BUG ID 273462 - Licensing: Nuke cannot retrieve a license from the license server when the hostname contains .local.
• BUG ID 272296 - Adding a user knob and then undoing the action doesn’t remove the added knob.
• BUG ID 271804 - Documentation: The node Properties panel ? link to the reference documentation doesn’t work as expected.
• BUG ID 271456 - UI: Some interface elements appear larger than usual when compared to previous versions of Nuke.
• BUG ID 271256 - Denoise: Rendering frames to disk with a Temporal Frame Offset greater than 1 causes Nuke to crash.
• BUG ID 271074 - PointCloudGenerator: Track Points does not work as expected when creating a point cloud from CameraTracker data.
• BUG ID 228258 - Calling fromScript() on a knob that has not been added causes Nuke to crash.
• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in the Preferences dialog.
• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp) > use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.
• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and --gpulist on the command line.
• BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer script.
• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4 when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather than SDI4.
• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then changing a value, such as Gain, causes Nuke to crash.
• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is changed.
• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system occasionally allows particles to pass through the bounce surface.
• BUG ID 42339 - The Modo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D control type) does not work as expected.
• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel doesn't work as expected.
• BUG ID 42159 - Nodes that use the iop::sample() call to get input pixels, such as LensDistortion, perform poorly when they are downstream of nodes using Planarlop, such as Denoise.
• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.
• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as the file path to the original.

⚠️ WARNING: If you save this empty script when the network drive is reconnected, the original is overwritten.

• BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on the Target for .mov clips with a frame range offset.
• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous versions.
• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-mouse button, pastes values into the control.
• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the mari_bridge.py file.
• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.
• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from the Node Graph.
• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.
• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format sizes causes corruption and constant refreshing in the Viewer.
• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in error when the path doesn't exist:

Flipbook render failed: viewerCaptureOp: Cannot write to specified path
• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images.
• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when mousing over the Viewer.
• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.
• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when render is set to off.
• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and Hiero.
• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.
• BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset nodes are ignored when connected to the cam or axis inputs.
• BUG ID 31803 - Using Shift+drag on a control's animation icon only copies the value for the current frame, not the entire expression.
• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding boxes for polymesh primitives.
• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.
• BUG ID 31238 - RAM cache: Any action that changes a frame's hash value, it's unique identifier, causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels dropdown affect the frame hash.
• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

NOTE: This known issue only applies to Roto and SplineWarp keys.

• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is copy/pasted in the Node Graph.
• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.
• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only displays the animated Camera in the Viewer. There should be two cameras: one static and one animated.
• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the new camera does not match that of the Viewer camera.
• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no longer available.
• BUG ID 20431 - CameraTracker: It's not possible to pick colors in the Viewer with the control panel open.
• BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.
• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer.
• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the Properties panel.
• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.
• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
  some large polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry **tessellation max** parameter.
• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
  zooming.
• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
  points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
  the other in 3D mode, and you have the panel for the RotoPaint visible.
• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
  per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
  the caching to work.
• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
  not restricted to, any nodes that have an analysis pass.
• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.
• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
  This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
  choose, the flipbook output is the same.
• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
  if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
  or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
  instead of NukeX.
• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.
• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
  when using **Create Scene**:
  • Select the Camera that was created in the 3D view when using the **Create Scene** button.
  • Press **F** to focus on the selected Camera. You can now navigate around the cloud. Do not try to
    focus (using **F**) on the point cloud. The resulting tumble camera movement is likely to be jumpy.
• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
  against an earlier version of Nuke.
Known Issues Specific to Nuke Studio and Hiero

AAF

- BUG ID 274824 - Elastic keyframes imported from Avid do not translate correctly into Nuke Studio.

Create Comp

- Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects > Create Comp.
- BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes Nuke Studio to crash when the Text nodes are disabled.
- BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the comp frame range compared to the annotations precomp frame range.
- BUG ID 41665 - There are currently no options to load or overwrite an existing script when you select Create Comp.

Exporting

- BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the Media tab Output Resolution setting for the track above, and produces output with incorrect formatting.
- BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when imported into Final Cut Pro.
- BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values from the Nuke Write Node Content preset.

Linux Only

- BUG ID 282599 - Linux only: Input and timecode metadata is currently incorrect in the timeline Viewer if the framerate is changed.
- BUG ID 239672 - Reading files from NTFS disks/partitions can be extremely slow, particularly for large files. This is a limitation of Linux NTFS file systems, rather than Foundry products.

We recommend avoiding timeline playback that relies on source footage from NTFS disks/partitions.
- BUG ID 235327 - CPU usage can reach 100% on a single thread during flipbooking, causing Nuke to become unresponsive.
- BUG ID 167058 - PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.
As a workaround, you can stop the pulseaudio daemon:
1. Open /etc/pulse/client.conf
2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not commented out.
3. Call ps -e | grep pulse to check the process is still running.
4. Call pulseaudio --kill
5. Call ps -e | grep pulse again to check the process has stopped.

• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio on Linux is scheduled for a later release.

• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes Nuke Studio to crash.

As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:

Mac OS X Only

• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and earlier.

This is a codec issue rather than an application issue.

• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to a conflict with the combination for the umlaut symbol.

To work around this, press U momentarily before Alt+U.

OCIO

• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke install path, causes a Could not load OpenColorIO config error on reload.

Preferences

• The Preferences > Path substitution table for cross platform compatibility currently only comes into effect at project load, not EDL/XML import.

As a workaround, import your sequence and set the Path substitution rule, then save the project and reload to force the conversion.
Python API

• BUG ID 50113 - QACTIONS are not added to the Edit menu in the menu bar when finding the menu action by name.

   As a workaround, use the **objectName** (**foundry.menu.edit**), where possible.

• BUG ID 44394 - Calling **hiero.core.addPathRemap()** does not work for soft effect file paths.

Read and Write

• BUG ID 278312 - Read/Write: The import progress bar occasionally persists after the import is complete, and cannot be closed.

   As a workaround, save and close the project, then restart Nuke Studio and reload the project.

• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in HieroPlayer 9.0.

• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml files.

• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the **Rendering** preference set to **limit renderer**.

   As a workaround, you can change the preference **Performance > Threads/Processes > Rendering > export renders** to **no renderer limits** to improve rendering speeds. You can also experiment with the custom renderer limits to adjust performance on your machine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

• BUG ID 39557 - Writing .exrs with 200+ layers, when **interleave** is set to **channels**, can be sluggish.

• BUG ID 36726 - Executing **Clip > Rescan Clip Range** displays frame read errors if the rescan adds frames to the clip.

• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to other applications, such as Premiere or Resolve.

• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default Nuke layer, such as **depth** or **motion**.

• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.

• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when added to the timeline.

Soft Effects

• BUG ID 280413 - Soft Effects: The Text effect cursor placement shifts incorrectly after typing first character.
• BUG ID 278275 - Soft Effects: Closing a Timewarp effect’s Properties panel disrupts the interface briefly.

• BUG ID 275314 - Soft Effects: Additional keyframes are added incorrectly when animating Text effects.

• BUG ID 230536 - The Burn-in effect does not maintain a constant text baseline for all characters when the format is changed.

• BUG ID 175574 - Undo and redo of Properties panel changes can be unreliable if a soft effect delete is in the same undo stack.

• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the associated sequence bin item to display an error.

• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100% does not work as expected.

• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be found.

• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between sequences until the playhead is moved.

• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the examples provided here:

  `<install_directory>/pythonextensions/site-packages/hiero/examples/custom_soft_effect.py`

• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying metadata is updated.

  As a workaround, either change the frame displayed in the Viewer or choose an alternate element from the dropdown controls.

• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the timeline.

• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above, causes text rendering to fail during the transition.

• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above, causes the text size to reset.

• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression writes incorrect frame numbers.

• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the Properties panel, if the node and effect names are identical.

• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the timeline.
• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the timeline.
• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available using the toolbar button on the timeline panel. The right-click Effects menu is currently disabled.

Timeline
• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the Viewer input buffers. You can still open clip instances in the various right-click Open In options and access clip instance metadata.
• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below existing tracks.

As a workaround, drag the clip to a new top-level track and then manually move the track to the required position.
• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the right-click Open in Timeline option.

Timeline Disk Caching
• BUG ID 280256 - Opening a Text effect's Properties panel directly after project load causes the cache bar to disappear.
• BUG ID 272897 - Caching continues after closing the project associated with the frames being cached.
• BUG ID 272541 - Changing the root directory for cached files can cause the disk cache state to become inconsistent.
• BUG ID 270934 - The caching logic does not currently account for gaps in sequences, resulting in the caching state icon remaining gray for fully cached sequences.

Windows Only
• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size depending on the timecode displayed.
• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous
• BUG ID 272723 - Closing Nuke Studio when it was launched from the command line does not end all Nuke processes.
• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.
• **BUG ID 167919** - Localization: Re-importing clips into the Node Graph or project bin multiple times retains the original localization policies settings.

• **BUG ID 50490** - Audio: Zooming in on a waveform displays a **Failed to decode audio** error in the timeline.

• **BUG ID 50102** - Adding a custom Hiero window to a workspace and then saving it as the Nuke default workspace causes Nuke to crash on start up.

• **BUG ID 46235** - Comps with relative paths are not currently working when imported into the project.

• **BUG ID 42462** - Cache pausing stops working if any change is made to the timeline.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plugins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td></td>
<td><img src="https://example.com/image.png" alt="API" /></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td><img src="https://example.com/image.png" alt="API" /></td>
<td><img src="https://example.com/image.png" alt="API" /></td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in `<install_directory>/plugins/nukescripts/` for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

There are no bug fixes in this release.
Release Notes for Nuke and Hiero
11.1v4

Release Date
07 June 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11.1, you'll need to upgrade the version of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.


• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement is driver version r361 which can be downloaded from [www.nvidia.com/drivers](http://www.nvidia.com/drivers).

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

### AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

### Mac GPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality. However:
• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU acceleration.

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

• BUG ID 134020 - Mac OS X/macOS only: Clicking a color swatch under Panels > Node Colors in the Preferences occasionally displayed the colorwheel behind the Preferences dialog.

• BUG ID 218448 - Node Graph: Adding node labels with large font sizes to the Node Graph occasionally caused the connection pipes between nodes to disappear.

• BUG ID 227958 - Linux only: Right-click context menus occasionally appeared on the wrong monitor.

• BUG ID 229820 - Viewer: The pixel sampler froze when a Read node's raw data control was toggled on and off.

• BUG ID 235461 - Mac OS X/macOS only: Restoring a dual screen workspace with a floating pane in the current workspace stacked all panels on one screen.

• BUG ID 335899 - ARRIRAW: Certain .ari files caused Nuke Studio to crash while caching frames in the RAM cache.

• BUG ID 338201 - macOS High Sierra only: Converting certain legacy .hrox projects to 11.1 caused Nuke Studio to crash.

• BUG ID 338278 - macOS only: Opening the Preferences displayed select: Invalid argument in the Terminal.

• BUG ID 338380 - Linux only: Clicking load settings from metadata did not work as expected for ARRIRAW .mxf files.

• BUG ID 338758 - Clicking Cancel during project load caused Nuke Studio to crash.

• BUG ID 339197 - Timeline Editing: Disabling or deleting a dissolve between certain shots caused Nuke Studio to crash.

• BUG ID 340199 - Write: Rendering a still image to a multi-frame .mov did not work as expected.
• BUG ID 340253 - Linux only: The Qt platform plug-in xcb was reported as missing from the build on Ubuntu distributions.
• BUG ID 340327/342384 - Create Comp: Rendering single frame comps occasionally displayed an **Unable to transcode, some clips being transcoded are in error state (perhaps colorspace is invalid)** message.
• BUG ID 342601 - Create Comp: Attempting to export unrendered single frame comps did not display a warning message.
• BUG ID 346808 - MXF: Loading a project in Hiero containing a large number of offline .mxf files displayed multiple error messages.
• BUG ID 347802 - Soft Effects: Adding a Timewarp effect to an .r3d or .ari shot changed the color output in the timeline Viewer.

New Known Issues Specific to this Release

This section covers new known issues and gives workarounds for them, where appropriate.

New Known Issues Specific to Nuke

• BUG ID 346731 - Linux only: Moving Roto shapes with a Wacom tablet installed exhibits lag in the Viewer.

As a workaround, set the QT_COMPRESS_TABLET_EVENTS environment variable to 1 in the current session. For example:

```bash
export QT_COMPRESS_TABLET_EVENTS=1
```

For legacy versions of Nuke where this variable does not exist, see the Support Portal article [here](#).
• BUG ID 339241 - MatchGrade: Clicking **Analyze Reference Frames** with a Read node with no valid file path displays an **Uncaught C++ exception occurred during the execution of python script!** error.
• BUG ID 316577 - macOS only: Current localization progress does not update if the pointer focus is on Nuke’s menu bar.
• BUG ID 312350 - Visual Diagnostics: The **Profile** tab occasionally flickers when the application window is maximized.
• BUG ID 309259 - Documentation: The Python Developers Guide incorrectly references Qt 4.8.5 source code.

For links to the correct source files, see the Nuke Developers page under **Nuke Qt binaries and source files**: [https://www.foundry.com/products/nuke/developers](https://www.foundry.com/products/nuke/developers)
• BUG ID 277875 - VFX Platform: Switching workspace occasionally draws the new workspace incorrectly.

New Known Issues Specific to Nuke Studio and Hiero

• BUG ID 314088 - Windows only: The first frame of localized files in the outdated state, colored red, do not always update correctly.
• BUG ID 313849 - Localization: Reading certain multiview .exr files causes Nuke to crash.

As a workaround, rename or move your .nuke folder and re-launch Nuke to refresh the uistate.ini file.
• BUG ID 313013 - Timeline Read Nodes: Opening the Node Graph from the Project bin and then returning to the timeline environment behaves as if the left mouse button is held down.

As a workaround, left-click in the timeline to cancel the mouse press.
• BUG ID 310067 - Timeline Read Nodes: Loading large projects is currently slower than expected.

Other Known Issues

This section covers legacy known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke

AudioRead

• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled between file and custom.
• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.
• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.
• BUG ID 18451 - Flipbooking doesn’t honor the time range knob.
• BUG ID 18217 - Redo keyframe generation doesn’t replace the keys.
• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn’t redraw the curves correctly.

BlinkScript/CUDA

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when the OS wakes up from sleep mode.

As a workaround, close and reopen Nuke to reactivate the CUDA drivers.
CameraTracker

- BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez modes.
- BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference thumbnails, rather than just the RGB values.

Deep

- BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then writes it to disk, causes Nuke to crash. As a workaround, run the script from the Script Editor inside Nuke.
- BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1. As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet

- BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you execute **Analyze Sequence** with the Dope Sheet open.
- BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.
- BUG ID 39426 - Undoing individually animated text characters removes their keys completely from the Dope Sheet.
- BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames when **frame snap** is enabled.
- BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.
- BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to have a non-empty frame expression.
- BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's **speed** control is animated.
- BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in the Dope Sheet.

EditGeo

- BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on geometry with animation baked into its vertices.

To update the transform handle, toggle the axis alignment control between **object** and **average normal**.
• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to ignore the EditGeo node.

• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe marker.

• BUG ID 36094 - Setting \textit{axis alignment} to \textit{average normal} displays the axis incorrectly on edge and corner vertices.

Flipbook

• BUG ID 271435 - Flipbook: Using the flipbook with nuBridge installed causes Nuke to crash.

• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in different output when compared to the Viewer.

As a workaround, either flipbook the node upstream of the Write node, or enable \textbf{Burn in the LUT} in the \textit{Flipbook} dialog.

• BUG ID 47005 - In the Flipbook Viewer, clicking the \textbf{Go to start} button always goes to frame 0, even if the clip doesn't start at 0.

• BUG ID 47005 - Enabling \textbf{Burn in the LUT} in the Flipbook dialog uses the \textit{rec709} LUT for both \textit{rec709} and \textit{rec1886}.

Frame Server

• BUG ID 273472 - Canceling or pausing a comp render in the \textbf{Background Renders} panel displays errors in the terminal.

• BUG ID 272523 - Non-contiguous frame ranges cannot currently be flipbooked.

GPU

• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke

• BUG ID 40131 - Importing Nuke in a Python script destroys \texttt{sys.argv}, making command-line arguments unavailable.

As a workaround, preserve \texttt{sys.argv} in another variable before you import Nuke.

• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other applications.

• BUG ID 38963 - Calling \texttt{import nuke} terminates the Python session if no applicable license is available.
Release Notes for Nuke and Hiero 11.1v4 | Other Known Issues

Linux Only

• BUG ID 271807 - Linux only: Adjusting pane or window borders left and right causes redraw lag.
• BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang during start up.

As a workaround, update your drivers to 361.42.

• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%, causing Nuke to become unresponsive.
• BUG ID 43766 - Calling \texttt{uuid.uuid4()} causes Nuke to crash due to a bug in \texttt{libc}.

As a workaround, launch Nuke from the command-line using:

\texttt{LD\_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0}

• BUG ID 42581 - Keyboard Shortcuts: Using \texttt{Ctrl+C} to quit Nuke from the command-line when a dialog box is open displays an error.
• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

LiveGroups

• BUG ID 274174 - Reloading a LiveGroup currently resets all edited User knobs.
• BUG ID 272281 - Adding a user knob and then undoing the action sets expression links to nodes with matching names in main Node Graph.

Mac OS X Only

• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers directly from NVIDIA here:

  \texttt{http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html}

• BUG ID 228076 - The PySide.QtUiTools library is currently missing from the Nuke build.
• BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to respond.
• BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above, when writing to SMB 2.1 and SMB 3 Sharepoint locations.
• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the Terminal.
• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.
• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save Report.

• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than one instance of Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT 650M.

As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one instance of Nuke at a time.

• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default.

For more information, see http://support.apple.com/kb/HT5293.

• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.

As a workaround, either:
  • tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or Samba, depending on source), or
  • using the command-line, copy the installation from Mac OS X to the network location using the same file system as the destination.

• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.

As a workaround, adjust the Viewer gain control to refresh the Viewer.

• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when Nuke is run from the command-line.

• BUG ID 13638 - The following graphics cards are not currently supported for Mac:
  • ATI Radeon X1600
  • ATI Radeon X1900

Users with these cards are able to render from the command-line, but in GUI sessions, the Node Graph renders incorrectly due to a requirement of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder

• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a ScanlineRender node causes Nuke to crash.
Monitor Out

• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at the extents of color ranges is incorrect.

As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB checkbox is enabled and the SDI Configuration is set to Single Link.

• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO

• BUG ID 201193 - Read node Metadata tabs occasionally include irrelevant in and out colorspace controls.

Particles

• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is out-of-date errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off are not reliably cleared when rendering through ScanlineRender.

• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within the particle system.

• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.

• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.

• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid lines.

Pixel Analyzer and Scopes

• BUG ID 44176 - PixelAnalyzer: The full frame sampling mode doesn't work immediately in the timeline Viewer when the analyzer is initially added to the layout.

• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the Viewer bounding box to 1x1 for that frame.

• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.

• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color transforms is enabled.
PrmanRender

- In the Nuke camera, the **window roll** control is not yet mapped to RenderMan.
- BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-in in the environment.plist file when in GUI mode.


Python

- BUG ID 271373 - A `QOpenGLContext::swapBuffers()` called with non-exposed window, behavior is undefined error is occasionally printed on the command line.
- BUG ID 44296 - Running `nuke.scriptOpen()` at the same time as creating a Python panel causes Nuke to crash.
- BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the command-line.

    Run the script from Nuke's **Script Editor** to avoid this issue.

- BUG ID 40645 - Using `setInput()` within an `onCreateCallback` doesn't work as expected.
- BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command-line.

    To work around this issue, run the Python script from Nuke's Script Editor.

- BUG ID 39308 - Accessing a node's x and y positions using the `xpos` and `ypos` controls reports incorrect values.

    As a workaround, either call `nuke.Node.xpos()` or `nuke.Node.ypos()` first, or ensure no nodes are currently selected in the Node Graph.

- BUG ID 38994 - `nuke.Node.screenWidth()` and `screenHeight()` are incorrect when a node is first created if it has an autolabel.

- BUG ID 8063 - Creating many new nodes with `nuke.createNode()` and the in-panel argument at default (True) may crash when too many node control panels are created too quickly. The workaround is to pass the in-panel argument as False or else use `nuke.nodes.NodeClass()` (where `NodeClass` is the type of node to create) to create the node and then connect it to the currently selected node manually.

- BUG ID 6455 - You should not call the Python command `nuke.restoreWindowLayout()` from the Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your `menu.py`, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar item.

- Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:
**groupName.NodeName.knobname: unexpected 'k' in '0.knobname'**

The problem is most likely that there is an expression using the input TCL command and doesn't validate that there is an input connected. An example expression:

```
[input parent 0].translate.x
```

The input command returns 0 when it can't find the requested input, which generates an expression of `0.knobname` that doesn't refer to anything. The fix is to restructure the expression to use the value TCL command and specify a default value to return in the case that the expression is invalid. It takes the form:

```
[value [input parent inputnumber].knob defaultvalue]
```

Here is the modified example:

```
[value [input parent 0].translate.x 0]
```

The modified example returns 0 in the event that there is no input 0, and no longer results in an error message.

- There is a Python syntax conflict when assigning knob names on the fly with `nuke.nodes.<node>()` if the knob is called 'in'.

For example, this gives a syntax error:

```
nuke.nodes.Shuffle(in = 'depth')
```

while this works because 'in' is a string here and not a keyword:

```
sh = nuke.nodes.Shuffle()
sh['in'].setValue('depth')
```

RayRender

- BUG ID 230256 - Soft Shadows are not currently supported.
- BUG ID 197294 - Reflection occlusion is not currently supported.
- BUG ID 196980 - Clipped alpha shadows are not currently supported.
- BUG ID 196776 - Multiple bounce reflecton is not currently supported.
- BUG ID 196124 - RayRender does not currently support refraction.
- BUG ID 195051 - The Wireframe shader node, located in 3D > Shader > Wireframe, is not supported by RayRender.
- BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.
- BUG ID 194819 - RayRender does not currently support Deep workflows.
• BUG ID 191108 - Particle sprites are not currently supported.
• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported by RayRender.

Read and Write

• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-line and GUI modes.
• BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file incorrectly.
• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.
• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an error decoding frame message in the Comp Viewer.
• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the rgba channels by default.
• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color shifts using QuickTime 10.3 codecs.
• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444.
• BUG ID 40074 - Writing out stereo .srx files with additional channels does not write out both eyes correctly.
• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect while toggling the read transform from file in combination with all objects and/or read on each frame.
• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a superfluous main view.
• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces, leaving gaps in certain circumstances.

This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the geometry.
• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.
• **BUG ID 21663** - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add new views.

• If you have trouble with FBX files, it may be because they were written with an older version of FBX. If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the FBX converter on the Autodesk website. It converts between various different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac OS X, and Linux.

To download the FBX converter:


2. Scroll down to FBX Converter and click on one of the links to start the download.

**Render codecs**

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the following:

• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance.

• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or above. You may need to download the Neoplayer at [http://estore.cineform.com/neoplayer.aspx](http://estore.cineform.com/neoplayer.aspx).

• If you're using Avid Meridien, you should only write out in NTSC and PAL.

**Roto/RotoPaint Open Splines**

• **BUG ID 42997** - Rendering artifacts can occur if the **feather** control is used in conjunction with the feather handles in the Viewer.

• **BUG ID 42995** - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and then manually change the Properties **view** control to include both views.

• **BUG ID 42991** - Python API: Moving points on an open spline using Python causes Nuke to crash.

• **BUG ID 42932** - Rendering artifacts can appear where the spline hull crosses over itself with negative **feather** values.

• **BUG ID 42422** - Rotating the tangent of an end point occasionally causes the hull to behave erratically.

• **BUG ID 42413** - Holding **Ctrl/Cmd** to move a point's tangent handles independently causes defects in the hull or feather.
• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally produces artifacts in the spline's hull.

• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is set to 0.

• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight rendering glitches inside the hull.

• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly from one point to the next

• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open Spline and Bezier tools.

Other Roto/RotoPaint Bugs

• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint color.

• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe creation.

• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same shape reverts the shape to its original position.

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn't extend to the current frame, disappear when drag-selected.

As a workaround, select the shape in the curves list to re-display the points.

• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn't work as expected.

[NOTE: This also applies to SplineWarp matrices.]

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.

• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in mind that they won't be backwards compatible with Nuke 6 once converted, unless you follow the instructions below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:

• Click Save As to convert the script to the Nuke 8 Roto format, or

• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:
  - You don't intend to make any changes, or
  - You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.
If you want Nuke 8 scripts to load in Nuke 6, use the `convertToNuke6` or `convertDirectoryToNuke6` Python functions when running Nuke 8 in command-line only mode:

⚠️ NOTE: The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6.

- To convert individual `.nk` scripts:
  ```python
  convertToNuke6(fromScript, toScript, overwrite = False)
  ```
- To convert all `.nk` scripts in a given directory:
  ```python
  convertDirectoryToNuke6(fromDir, toDir, matchPattern = '*.\nk', overwrite = False)
  ```

⚠️ NOTE: The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command-line (or Terminal):

```bash
$ <NukeInstallDir>/Nuke8.0v1 -t
>>> import nuke.rotopaint
```

- **BUG ID 26855** - The `undo` and `redo` buttons in the Properties panel didn’t work as expected and have been disabled.

  The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the Edit menu instead.

- **BUG ID 21361** - Artifacts are produced until mouse up when painting over a stroke on another frame.
- **BUG ID 11524** - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.
- **BUG ID 9238** - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of the screen.
- The foreground onion skin overlay updates as you paint, rather than only updating with the new stroke on pen up.
- It is not currently possible to clone RotoPaint nodes.
- Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled on the layer you are working in.

### ScanlineRender

- **BUG ID 38329** - Deep renders from ScanlineRender currently ignore the ScanlineRender's `bg` input.
- **BUG ID 38205** - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi transparent areas.
• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.

SmartVector Toolset

• BUG ID 275683 - SmartVector: Due to VFX Platform library changes, vectors generated by the Nuke 11 SmartVector toolset do not match legacy versions. For example, vectors generated by Nuke 11.0v1 do not match those generated by Nuke 10.5v4.

• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node occasionally displays a spurious No such file or directory error.

As a workaround, scrub to a different frame to remove the message.

• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file browser icon does not open the file browser.

As a workaround, click OK on the error message and then click the file browser icon again.

Text

• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control differently, producing inconsistent output.

• BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer overlay is disabled.

• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does not work as expected.

As a workaround, expression link the translate x and y controls separately.

• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame where the character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting the message field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.

• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

• BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in the Viewer.

Tracker

• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked frames.
As a workaround, you can enable full frame processing, though this may increase render times.

- **BUG ID 40038** - **Ctrl/Cmd** clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor coordinates to 0,0.
- **BUG ID 39225** - Moving tracking anchors is occasionally unresponsive and jerky.
- **BUG ID 39200** - Holding **Shift** and clicking tracks in the Viewer doesn't add to the current selection.
- **BUG ID 38356** - The zoom window occasionally doesn't update correctly when scrubbing between frames.
- **BUG ID 32359/32353** - Right-clicking on a point in the Viewer doesn't always update the available **Link to** > **Tracker linkingdialog** or **Tracker** options.

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the **Link to** menu.

- **BUG ID 29382** - Tracking keyframes with different sized patterns doesn't work as expected.

As a workaround, keyframe patterns should, where possible, be of comparable sizes.

**VFX Platform**

- You may experience issues when importing PySide modules into their Python scripts due to the migration from PySide 1.2.2 to PySide 2.0.

In some cases, you can just change calls to:

import Pyside.some_module

to:

try:
    import Pyside.some_module
except:
    import Pyside2.some_module

However, the definition of some classes has moved between modules in PySide 2.0. This particularly affects any Widget related classes, which have been moved from QtGui to QtWidgets, however there are other cases where this may be experienced.

If you experience any problems with this, please refer to the Qt 5.6.1 documentation, or contact support.foundry.com.

- **BUG ID 282593** - Switching to a fullscreen workspace on the primary monitor occasionally causes the secondary monitor to turn black.
RELEASE NOTES

• BUG ID 280371 - Mac OS X/macOS only: OpenGL errors are printed on the command line when using an ATI Radeon 5770 GPU.
• BUG ID 277548 - A QComboBox with a custom QCompleter currently emits incorrect signals.
• BUG ID 275719 - Mac OS X/macOS only: The Help > About Nuke pop-up is positioned incorrectly on some machines.
• BUG ID 275251 - Mac OS X/macOS only: Hovering over clip instances in the timeline does not change the pointer icon.
• BUG ID 275246/270914 - The terminal or command line displays libpng warning: iCCP: cHRM chunk does not match sRGB on start-up.
• BUG ID 274301 - Node toolbar menu items do not always deselect correctly.
• BUG ID 274264 - CameraTracker results from Nuke 11.1 are not identical to previous versions of Nuke, though the differences are negligible.
• BUG ID 272767 - Launching Nuke from the terminal with the -b argument has been deprecated as a result of library upgrades to comply with the VFX Platform 2017 requirements. There are two workarounds available on Mac and Linux:
  • Run Nuke from the Terminal with & added to the launch command. This allows Nuke to run in the background and returns the command prompt, but closing the Terminal still causes Nuke to close. For example:
    ./Nuke11.1v1 --studio &
  • Run Nuke from the Terminal using the nohup command. This allows Nuke to run in the background and returns the command prompt, but closing the Terminal does not cause Nuke to close. For example:
    nohup ./Nuke11.1v1 --studio &

TIP: The nohup command prints output to /Users/<username>/nohup.out or /home/<username>/nohup.out by default, but you can specify a different file by appending > /filepath/ filename to the command. For example:

    nohup ./Nuke11.1v1 --studio & > /Users/<username>/nuke.out

• BUG ID 272750 - The remove all panels button in the node Properties panel is displayed inconsistently.
• BUG ID 272504 - The timeline Viewer in and out point previews are not working as expected when scrubbing.
• BUG ID 272442/281108 - The Licensing dialog jitters when moved around the screen.
• BUG ID 272338 - The Windows command prompt displays QWidget::paintEngine: Should no longer be called on launch.
• BUG ID 272274 - Closing Nuke Studio does not remove the application icon from the task bar.
• BUG ID 271632 - Nuke prints a libDeckLinkAPI.so error in the terminal on launch.
Warpers

- BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display an overlay until pen-up.
- BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which cannot be undone.
- BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are removed.
- BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be undone.
- BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to a new layer.
- BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
- BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the cropped image and the black area between the crop box and the format when merged over a background.
- BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines.
- BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set at an intermediate value.
- BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering problems.
- BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode with mix set at an intermediate value.
- BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather than just the latest, and the keyframes remain on the timeline and in the properties.
- BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.
- BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add Correspondence Point tool.
- BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is not visible in the Viewer.
- BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not undo as expected.
- BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet.
- BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the Draw Boundary Viewer button.
• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of the Viewer, particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split controls into separate views.

Windows Only

• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then clicking Quit, causes Nuke Non-commercial to crash on exit.

As a workaround, change the mode a few times until it work as expected.

• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.

• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.

As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.

• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you use the erase end of the pen.

• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422 (2vuy) pixel format due to a bug in the codec, resulting in solid green frames.

As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.

• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node, such as Primatte or Shuffle, even after the node is removed from the Node Graph.

• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous

• BUG ID 273462 - Licensing: Nuke cannot retrieve a license from the license server when the hostname contains .local.

• BUG ID 272296 - Adding a user knob and then undoing the action doesn't remove the added knob.

• BUG ID 271804 - Documentation: The node Properties panel ? link to the reference documentation doesn't work as expected.

• BUG ID 271456 - UI: Some interface elements appear larger than usual when compared to previous versions of Nuke.

• BUG ID 271256 - Denoise: Rendering frames to disk with a Temporal Frame Offset greater than 1 causes Nuke to crash.
• BUG ID 271074 - PointCloudGenerator: **Track Points** does not work as expected when creating a point cloud from CameraTracker data.

• BUG ID 228258 - Calling **fromScript()** on a knob that has not been added causes Nuke to crash.

• BUG ID 226394 - Preferences: There are currently duplicate **Script Editor** controls under **Other** in the Preferences dialog.

• BUG ID 169458 - Compositing Viewer: Setting the **gamma** control to 0 with **Panels > Viewer (Comp)** > **use GPU for Viewer when possible** enabled in the preferences, renders the alpha channel black.

• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and **--gpulist** on the command line.

• BUG ID 50715 - ZDefocus: Switching the **filter type** to **image** causes Nuke to crash in a customer script.

• BUG ID 49803 - AJA Monitor Output: Setting the **NUKE_AJA_CHANNEL** environment variable to 4 when the **NUKE_AJA_DUALOUTPUT** environment variable is set, streams the output to SDI3, rather than SDI4.

• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the **Ranges** tab and then changing a value, such as **Gain**, causes Nuke to crash.

• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is changed.

• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system occasionally allows particles to pass through the bounce surface.

• BUG ID 42339 - The **Modo** Viewer control scheme (**Preferences > Panels > Viewer Handles > 3D control type**) does not work as expected.

• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's **alpha** channel doesn't work as expected.

• BUG ID 42159 - Nodes that use the **lopal::sample()** call to get input pixels, such as LensDistortion, perform poorly when they are downstream of nodes using Planarlop, such as Denoise.

• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.

• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as the file path to the original.

**WARNING:** If you save this empty script when the network drive is reconnected, the original is overwritten.

• BUG ID 41122 - MatchGrade: **Match Different Clip** mode does not allow you to set keyframes on the **Target** for **.mov** clips with a frame range offset.

• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous versions.
• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-mouse button, pastes values into the control.
• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the mari_bridge.py file.
• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.
• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from the Node Graph.
• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.
• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format sizes causes corruption and constant refreshing in the Viewer.
• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in error when the path doesn't exist:

    Flipbook render failed: viewerCaptureOp: Cannot write to specified path
• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images.
• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when mousing over the Viewer.
• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.
• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when render is set to off.
• BUG ID 32497 - The R3D parameter labels in Nuke aren't entirely consistent with REDCINE-X and Hiero.
• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.
• BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset nodes are ignored when connected to the cam or axis inputs.
• BUG ID 31803 - Using Shift+drag on a control's animation icon only copies the value for the current frame, not the entire expression.
• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding boxes for polymesh primitives.
• BUG ID 31310 - TimeOffset: Checking reverse input doesn't affect cameras, lights, or axes.
• BUG ID 31238 - RAM cache: Any action that changes a frame's hash value, it's unique identifier, causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels dropdown affect the frame hash.
• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

[NOTE: This known issue only applies to Roto and SplineWarp keys.]

• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is copy/pasted in the Node Graph.
• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.
• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only displays the animated Camera in the Viewer. There should be two cameras: one static and one animated.
• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the new camera does not match that of the Viewer camera.
• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no longer available.
• BUG ID 20431 - CameraTracker: It's not possible to pick colors in the Viewer with the control panel open.
• BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.
• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer.
• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the Properties panel.
• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.
• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because some large polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry tessellation max parameter.
• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or zooming.
• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and the other in 3D mode, and you have the panel for the RotoPaint visible.
• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for the caching to work.
• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is not restricted to, any nodes that have an analysis pass.
• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.
Nuke runs correctly from a network install on Windows without specifically installing the run-time libraries, though we still recommend that you do so as there are still some minor problems without them.

- **BUG ID 5083** - Flipbooking the output of the Anaglyph node asks which view you want to render. This question is unnecessary as the result is an anaglyph image. Irrespective of what view you choose, the flipbook output is the same.

- File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke instead of NukeX.

- **CameraTracker**: Canceling lens distortion initialization results in corrupt tracks.

- **3D Camera**: If you want to navigate through the 3D point cloud created by the CameraTracker node when using **Create Scene**:
  - Select the Camera that was created in the 3D view when using the **Create Scene** button.
  - Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.

- Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled against an earlier version of Nuke.

### Known Issues Specific to Nuke Studio and Hiero

**AAF**

- **BUG ID 274824** - Elastic keyframes imported from Avid do not translate correctly into Nuke Studio.

**Create Comp**

- Multi-view, such as stereoscopic, is not supported for clip instances created using right-click **Effects** > **Create Comp**.

- **BUG ID 47044** - Inserting scripts into comps containing Text nodes using unsupported fonts causes Nuke Studio to crash when the Text nodes are disabled.

- **BUG ID 46470** - Create Comp: Enabling **Collate Shot Name** in the comp export preset offsets the comp frame range compared to the annotations precomp frame range.

- **BUG ID 41665** - There are currently no options to load or overwrite an existing script when you select **Create Comp**.
Exporting

• BUG ID 49024 - Enabling the **Collate...** options in the **Export** dialog when exporting ignores the **Media** tab **Output Resolution** setting for the track above, and produces output with incorrect formatting.

• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when imported into Final Cut Pro.

• BUG ID 46403 - Controls set in the **Export** dialog **Content** tab occasionally default to the values from the **Nuke Write Node** Content preset.

Linux Only

• BUG ID 282599 - Linux only: Input and timecode metadata is currently incorrect in the timeline Viewer if the framerate is changed.

• BUG ID 239672 - Reading files from NTFS disks/partitions can be extremely slow, particularly for large files. This is a limitation of Linux NTFS file systems, rather than Foundry products.

We recommend avoiding timeline playback that relies on source footage from NTFS disks/partitions.

• BUG ID 235327 - CPU usage can reach 100% on a single thread during flipbooking, causing Nuke to become unresponsive.

• BUG ID 167058 - PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.

As a workaround, you can stop the **pulseaudio** daemon:

1. Open `/etc/pulse/client.conf`
2. Set `autospawn = no` and `daemon-binary` to `/bin/true`. Ensure these lines are not commented out.
3. Call `ps -e | grep pulse` to check the process is still running.
4. Call `pulseaudio --kill`
5. Call `ps -e | grep pulse` again to check the process has stopped.

• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio on Linux is scheduled for a later release.

• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes Nuke Studio to crash.

As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:

Mac OS X Only

• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and earlier.

This is a codec issue rather than an application issue.

• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to a conflict with the combination for the umlaut symbol.

To work around this, press U momentarily before Alt+U.

OCIO

• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke install path, causes a **Could not load OpenColorIO config** error on reload.

Preferences

• The **Preferences > Path substitution** table for cross platform compatibility currently only comes into effect at project load, not EDL/XML import.

As a workaround, import your sequence and set the **Path substitution** rule, then save the project and reload to force the conversion.

Python API

• BUG ID 50113 - QACTIONS are not added to the **Edit** menu in the menu bar when finding the menu action by name.

As a workaround, use the **objectName** (**foundry.menu.edit**), where possible.

• BUG ID 44394 - Calling **hiero.core.addPathRemap()** does not work for soft effect file paths.

Read and Write

• BUG ID 278312 - Read/Write: The import progress bar occasionally persists after the import is complete, and cannot be closed.

As a workaround, save and close the project, then restart Nuke Studio and reload the project.

• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in HieroPlayer 9.0.

• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere **.xml** files.
• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the Rendering preference set to limit renderer.

As a workaround, you can change the preference Performance > Threads/Processes > Rendering > export renders to no renderer limits to improve rendering speeds. You can also experiment with the custom renderer limits to adjust performance on your machine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.
• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.
• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds frames to the clip.
• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to other applications, such as Premiere or Resolve.
• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default Nuke layer, such as depth or motion.
• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.
• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when added to the timeline.

Soft Effects

• BUG ID 280413 - Soft Effects: The Text effect cursor placement shifts incorrectly after typing first character.
• BUG ID 278275 - Soft Effects: Closing a Timewarp effect’s Properties panel disrupts the interface briefly.
• BUG ID 275314 - Soft Effects: Additional keyframes are added incorrectly when animating Text effects.
• BUG ID 230536 - The Burn-in effect does not maintain a constant text baseline for all characters when the format is changed.
• BUG ID 175574 - Undo and redo of Properties panel changes can be unreliable if a soft effect delete is in the same undo stack.
• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the associated sequence bin item to display an error.
• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100% does not work as expected.
• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be found.
• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between sequences until the playhead is moved.
• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the examples provided here:

<install_directory>/pythonextensions/site-packages/hiero/examples/custom_soft_effect.py

• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying metadata is updated.

As a workaround, either change the frame displayed in the Viewer or choose an alternate element from the dropdown controls.

• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the timeline.

• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above, causes text rendering to fail during the transition.

• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above, causes the text size to reset.

• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression writes incorrect frame numbers.

• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the Properties panel, if the node and effect names are identical.

• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the timeline.

• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the timeline.

• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available using the toolbar button on the timeline panel. The right-click Effects menu is currently disabled.

Timeline

• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the Viewer input buffers. You can still open clip instances in the various right-click Open In options and access clip instance metadata.

• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below existing tracks.

As a workaround, drag the clip to a new top-level track and then manually move the track to the required position.

• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the right-click Open in Timeline option.
Timeline Disk Caching

• BUG ID 280256 - Opening a Text effect's Properties panel directly after project load causes the cache bar to disappear.
• BUG ID 272897 - Caching continues after closing the project associated with the frames being cached.
• BUG ID 272541 - Changing the root directory for cached files can cause the disk cache state to become inconsistent.
• BUG ID 270934 - The caching logic does not currently account for gaps in sequences, resulting in the caching state icon remaining gray for fully cached sequences.

Windows Only

• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size depending on the timecode displayed.
• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous

• BUG ID 272723 - Closing Nuke Studio when it was launched from the command line does not end all Nuke processes.
• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.
• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times retains the original localization policies settings.
• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the timeline.
• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke default workspace causes Nuke to crash on start up.
• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.
• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plugins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

• BUG ID 229953 - Python: Calling `hiero.core.Project.beginUndo()` stopped `hiero.core.Clip.setSourceMediaColourTransform()` working as expected.

• BUG ID 315469 - Python: Calling `rawView()` before and after saving a project did not return the same result.

• BUG ID 324013 - Python: Creating an empty sequence Pythonically occasionally caused Nuke Studio to crash.

• BUG ID 335273 - Python: Calling `Clip.setSourceMediaColourTransform()` caused Hiero to crash.

• BUG ID 341714 - Python: Calling `findNewVersions()` on container formats, such as `.mov` and `.mp4`, returned all versions of the clip, including the current version.

• BUG ID 347725 - Python: The Hiero example file `custom_transcode.ui.py` did not work as expected.

• BUG ID 347885 - Python: Adding a PySide2 window in Nuke's `menu.py` script using `QWidget` displayed a missing attribute `statusBar` exception.
Release Notes for Nuke and Hiero 11.1v3

Release Date

12 April 2018

Qualified Operating Systems

- macOS Sierra (10.12) or macOS High Sierra (10.13)
- Windows 7 or Windows 10 (64-bit)
- CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11.1, you'll need to upgrade the version of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.


• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality. However:
• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.
• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU acceleration.

New Features

There are no new features in this release.

Feature Enhancements

• The Nuke online help has been updated to a more responsive top navigation style.
• BUG ID 151366 - Deep: DeepWrite nodes are now auto-labeled in the same way as regular Write nodes.

Bug Fixes

• BUG ID 150257 - Deep: Dragging files containing Deep data into the Node Graph created a regular Read node, rather than a DeepRead or ReadGeo node.
• BUG ID 195999 - Expressions: Using `sample this.input` in an expression did not update correctly and displayed an error.
• BUG ID 245250 - ProjectionSolver: Adjusting the Radial Distortion controls caused Nuke to crash.
• BUG ID 246110 - Double-clicking on Card node geometry in the 3D Viewer caused Nuke to crash.
• BUG ID 247360 - Enabling `motionblur` in a Transform node downstream of a CornerPin and FrameHold node ignored the FrameHold.
• BUG ID 253318 - Linux only: Rendering a customer script occasionally caused Nuke to crash.
• BUG ID 263058 - PrmanRender: Connecting a PrmanRender node in the Node Graph with RenderMan Pro Server 21 installed caused Nuke to crash.
• BUG ID 266446 - Export: Copy Exporter presets did not always copy `.wav` files in sequences correctly.
• BUG ID 280470 - Curve Editor: The right-click Predefined commands could not be applied in scripts with multiple views.
• BUG ID 280582 - Group: Read nodes with `postage stamp` enabled, but no valid file path, caused Nuke to crash on opening another comp.
• BUG ID 303471 - DeepWrite: Setting the frame to start at and entering a value caused Nuke to crash.
• BUG ID 306493 - Right-clicking a Read node containing custom knobs and selecting Edit > Copy as Clones displayed a no such knobs error message.
• BUG ID 310649 - LiveGroups: Modifying unlinked user knobs did not set the LiveGroup to the edited state.
• BUG ID 316485 - MatchGrade: Clicking Analyze Reference Frames with a Read node with no valid file path caused Nuke to crash.
• BUG ID 323754 - Timeline Read Nodes: Clicking rescan in a shot's Properties panel, or right-clicking a shot and selecting Clip > Rescan Clip Range, and then undoing the action retrieved the wrong frame range in split sequences.
• BUG ID 325023 - Non-commercial: Saving projects in Nuke Studio non-commercial appended .hroxnc to the .hrox extension, rather than replacing it.
• BUG ID 325550 - Preferences: Opening Color wheel swatches in a separate floating window always displayed the window at the default position and size, regardless of any custom changes.
• BUG ID 327910 - Toolsets: The P_SnowRain toolset was incomplete and did not display the geometry bounding box correctly.
• BUG ID 328083 - Create Comp Special: Setting the Nuke Write Node > File Type control to export .targa files failed silently, creating an empty VFX track.
• BUG ID 328938 - ARRIRAW: Enabling the Noise Reduction control in a source clip or shot's Properties panel did not work as expected.
• BUG ID 331027 - LiveGroups: Saving, closing, and reopening a LiveGroup script or copying and pasting a LiveGroup node discarded any Python or text data created through user knobs.
• BUG ID 331180 - Particles: The ParticleSpeedLimit node did not work as expected.
• BUG ID 331214 - Export: Read nodes exported from Nuke Studio didn't inherit the missing frames control values specified in the associated timeline Read nodes.
• BUG ID 331987 - Expressions: Multiview knobs did not clone links correctly from the new view to the original view if the original view was calling an expression.
• BUG ID 332470 - Timeline Read Nodes: Versioning a shot up or down displayed the wrong colorspace in the Properties panel.
• BUG ID 332744 - Preferences: The colorspaces defined under Project Defaults > Color Management were not applied to new clips as expected.
• BUG ID 332804 - Colorspace: Versioning a clip up or down did not update the Viewer colorspace correctly.
• BUG ID 333697 - Documentation: The arguments for the ldexp(x,exp) expression were documented incorrectly.
• BUG ID 334474 - Export: Opening a project containing versioned clips and Nuke scripts with similar names caused Hiero to crash.
• BUG ID 334558 - Node Graph: Expression links were not displayed by default in the Node Graph.
• BUG ID 335467 - Colorspace: **Build Track from Export Structure** displayed a colorspace index error when executed before exporting the shots.

• BUG ID 335929 - Localization: Entering a different **localize to** directory in the **Preferences** localized media to the default Nuke temp directory.

• BUG ID 337474 - ARRIRAW: Importing certain .ari files caused Nuke Studio to crash.

• BUG ID 340091 - Documentation: The reference section controls for the MatchGrade **Create OCIOFile-Transform** button were incorrect.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plugins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescrscripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

• BUG ID 176558 - Python: Nuke returned incorrect values from the Camera node's `world_matrix` knob.
• BUG ID 199547 - Python: A customer's Deep plug-in calling `error()` within a validate function caused Nuke to crash.
• BUG ID 219649 - Python: Deleting an `.exr` Write node containing a `Knob Changed` callback caused Nuke to display an error on exit.
• BUG ID 246037 - Python: Calling `nuke.Menu.setShortcut` in the Script Editor caused Nuke to crash.
• BUG ID 252736 - Python: Querying a new `format()` that didn't have a name caused Nuke to crash.
• BUG ID 253579 - Python: `Array_Knob.setExpression()` ignored the `view` argument.
• BUG ID 253591 - Python: `Node.metadata()` returned incorrect values for multiple views.
• BUG ID 313295 - Python: Calling `getValueAt` did not return the correct view in scripts with multiple views.
• BUG ID 324027 - Python: The `versioning_example.py` called an incorrect attribute.
Release Notes for Nuke and Hiero 11.1v2

Release Date
21 February 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11.1, you'll need to upgrade the version of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.


• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality. However:
• If you’re running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.

• If you’re running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU acceleration.

New Features

There are no new features in this release.

Feature Enhancements

• BUG ID 197704 - Nuke, Nuke Studio, and Hiero now support .mxf ARRIRAW container files from the ARRI Alexa Mini and Amira cameras.

• BUG ID 249925 - Monitor Output: SDI out monitors now maintain the correct aspect ratio when the Viewer is in A/B mode.

Bug Fixes

• BUG ID 133292 - DeepRead: Linked expressions did not return the correct width and height values.

• BUG ID 137180 - DeepRead: Explicitly specifying a file extension before the file path in the file control ignored the missing frames control.

• BUG ID 137350 - DeepReformat: Enabling black outside did not work as expected in output from ScanlineRender nodes.

• BUG ID 152061 - Group: Picking a knob in a Group temporarily duplicated tabs in the Group's Properties panel.

• BUG ID 154861 - DeepRead: Nuke could not read .exr files larger than 2 GB.

• BUG ID 156579 - DeepToPoints: Generating DeepEXR files without RGB channels caused Nuke to crash.

• BUG ID 157666 - DeepRecolor: Enabling target input alpha caused Nuke to output NaN values.

• BUG ID 157999 - ARRIRAW: Certain ARRIRAW files caused Nuke to crash or display an error.

• BUG ID 158765 - DeepRecolor: Enabling target input alpha flattened deep channels that should not have been included in the copy operation.

• BUG ID 162477 - Windows only: A customer script containing audio files caused Nuke to crash on save/autosave.

• BUG ID 163699 - DeepExpression: The == operator could not successfully compare two knob values when they were both set to 0.
• BUG ID 186119 - Projects containing .jpg shots with corrupt EXIF data could not be opened in Nuke Studio.
• BUG ID 196827 - OCIO: Loading a saved script referencing default fallback OCIO colorspaces placed OCIO nodes in an error state.
• BUG ID 221077 - ARRIRAW: Importing certain .ari files caused Nuke to crash.
• BUG ID 239158 - Conform: Conforming a customer .xml file containing .r3d shots with overlapping timecodes caused Nuke Studio to crash.
• BUG ID 244849 - Ingest: Directories containing increasing sequential numbers in their name were imported incorrectly.
• BUG ID 251326 - Versioning: Write nodes in scripts exported from Nuke Studio did not always version up as expected using File > Save New Comp Version.
• BUG ID 267226 - Timeline Editing: Audio-only sequences did not cache as expected.
• BUG ID 267697 - Create Comp: Comps created from multiple shots did not respect the To Sequence Resolution control.
• BUG ID 271208 - Altering the number of frames in a clip caused associated shots to slip by one frame on the timeline.
• BUG ID 272450 - Timeline Disk Caching: A TimelineCache folder was added incorrectly to the Nuke install directory.
• BUG ID 279513 - Create Comp: Nuke Studio ignored the {_nameindex} token causing comp creation to fail.
• BUG ID 282638 - Read/Write: Nuke Studio could not read DNxHD 64-bit .mov files.
• BUG ID 303503 - Create Comp: Setting the color space to REDWideGamutRGB for .r3d shots caused comp creation to fail.
• BUG ID 306228 - Opening Nuke's browser displayed errors on the command line.
• BUG ID 309417 - Documentation: The Python Developers Guide referenced the outdated PySide and PyQt4 modules.
• BUG ID 310356 - Monitor Output: Playback of 4K .dpx files at 25 fps was not possible on some machines when monitor out was active.
• BUG ID 317185 - Python: Opening Nuke Studio using a customer .py script created duplicate menus.
• BUG ID 317589 - Text: The first character entered was not displayed in the expected place.
• BUG ID 317610 - Soft Effects: Using expressions in a Text effect and then creating a group and enabling transform, caused Nuke Studio to crash.
• BUG ID 322584 - Timeline Viewer: The playhead did not move as expected during playback of audio files opened in the Timeline View.
• BUG ID 322910 - Deep: DeepMerge nodes set to holdout produced a less accurate result when compared to DeepHoldout nodes.
• BUG ID 322939 - Timeline Read Nodes: Missing frames at the start of a clip caused the clip's range to start with the first frame present.
• BUG ID 323132 - Timeline Read Nodes: Clicking rescan in the Properties panel did not work as expected for certain split sequences.
• BUG ID 323322 - Timeline Disk Cache: Opening or closing a soft effect's Properties panel temporarily cleared cached frames within the extent of the effect.
• BUG ID 323777 - Timeline Editing: Playing back audio-only files stopped the Viewer refreshing correctly.
• BUG ID 323820 - Export: Changing the OpenColorIO Config settings under Project > Edit Settings > Color Management caused exports to display an error in the Viewer.
• BUG ID 323822 - Audio: Opening audio files in the Timeline View occasionally caused them to play back too quickly.
• BUG ID 324013 - Python: Creating empty sequences occasionally caused Nuke Studio to crash.
• BUG ID 324468 - Localization: Setting the localize to preference to / (forward slash) caused Nuke to crash.
• BUG ID 324597 - Timeline Editing: Duplicating a sequence multiple times caused Nuke Studio to become unresponsive.
• BUG ID 324996 - Visual Diagnostics: Setting channels to all with non-rgba channels connected to the Profile node caused profiling to fail.
• BUG ID 325049 - Conversion of certain legacy projects to Nuke 11.1 did not work as expected.
• BUG ID 325677 - Timeline Disk Caching: Caching multiple sequences containing the same shots occasionally stopped the Clear Sequence Range function working correctly.
• BUG ID 326776 - Tracker: Exporting track information created multiple expression links if a Transform node with the same name already existed in the script.
• BUG ID 326864 - Timeline Read Nodes: Converting projects to the new 11.1 .hrox format caused ARRIRAW footage to load at the wrong resolution and display errors.
• BUG ID 327544 - Tags: Filtering a bin search using tags did not work as expected.
• BUG ID 327792 - Timeline Read Nodes: Converting projects to the new 11.1 .hrox format caused Nuke Studio to become unresponsive when closing the application.
• BUG ID 328460 - Timeline Editing: Custom sequence formats that were not in use were not saved after closing the project.
• BUG ID 329390 - Heavy scripts took longer to load in Nuke 11.1 than in Nuke 11.0.
• BUG ID 329542 - Timeline Disk Caching: Loading an autosaved project containing cached frames caused Nuke Studio to crash when executing Save Project As.
• BUG ID 329787 - Windows only: Opening the file browser with an NFS drive mounted caused Nuke to crash.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plugins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Additionally, node Class() names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

• BUG ID 270590 - Python: Calling `onScriptClose()` on a `file` knob evaluated from metadata caused Nuke to crash.

• BUG ID 270776 - Linux only: `QWebEngine` was missing from the Qt 5.6.1 build.

• BUG ID 303798 - The `Pyside2uic` module was missing.

• BUG ID 312575 - Python: Setting a node's name using `node['name'].setValue()` allowed the use of illegal characters.

• BUG ID 322919 - Linux only: The PySide2 binary tools, shiboken2, pyside2-lupdate, and pyside2-rcc, were corrupt in the Linux bundle.

• BUG ID 323320 - Calling `nuke.localization.pauseLocalization()` didn't pause localization.

• BUG ID 324013 - Python: Creating empty sequences occasionally caused Nuke Studio to crash.
Release Notes for Nuke and Hiero 11.1v1

Release Date
07 December 2017

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11.1, you'll need to upgrade the version of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Driver version r361 or above is required.


• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement is driver version r361 which can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

<table>
<thead>
<tr>
<th>Windows GPU</th>
<th>Driver</th>
<th>Linux GPU</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W8100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
<td>AMD FirePro W9100</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon R9 Fury X</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon R9 Fury X</td>
<td>17.10</td>
</tr>
<tr>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
<td>AMD Radeon RX 480</td>
<td>17.Q2.1</td>
</tr>
<tr>
<td>AMD Radeon Pro WX 7100</td>
<td>17.4.3 - 17.6.2</td>
<td>AMD Radeon Pro WX 7100</td>
<td>17.10</td>
</tr>
</tbody>
</table>

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality. However:
• If you’re running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.
• If you’re running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU acceleration.

New Features

Localization Improvements

Nuke and Nuke Studio’s file localization feature has been improved. The Preferences > Performance > Localization menu has been updated, offering a new manual mode as well as color codes to indicate the state of localized Read nodes and source clips.

The new manual localization mode does not localize any files automatically, but checks in the background for updates to the source files, notifying you if they become outdated. When the localization policy is set to on demand or on you can update outdated Read nodes and source clips by clicking the Update button in the Properties panel.

The improvements also include a new pause localization on script/project load preference. When enabled, no new localization takes place when you load a script or project, which can speed-up load times.

Timeline Read Nodes

You can now double-click Nuke Studio source clips and shots on the timeline to open Read node-like Properties panels. Timeline Read nodes contain a subset of the full Read node controls, including file path, localization policy, and colorspace. For specialized Reads, like R3D and ARRIRAW, additional controls are available, just like in the Node Graph.

In addition, source clip properties are accessible through the same Python API as Nuke, improving scripting capabilities and integration into existing pipelines.

Visual Diagnostics

Nuke can now display accurate script profile data onscreen or output it to .csv or .xml file to help you troubleshoot bottlenecks in slow scripts. When visual diagnostics are calculating, timing information is displayed in the Node Graph, and the nodes themselves are colored according to the proportion of
the total processing time spent in each one. The data is then displayed in the Profile tab as a bar or pie chart, timeline, or as a table.

Feature Enhancements

• BUG ID 143908 - Expressions: A new Performance > Expressions > Mode preference has been added, controlling how expressions in the Node Graph are evaluated. After an initial evaluation on all expressions to find dependencies, the default mode, Lazy, only re-evaluates expressions when needed. This can help with UI performance in some circumstances.

If you require constant expression evaluation, set the Mode to Always, which causes Nuke to behave as in previous releases.

• BUG ID 169843 - BlinkScript: An error message is now printed in the Viewer, as well as in the initial error dialog, providing more information about compilation errors.

• BUG ID 173220 - The BlinkScript node and soft effect now support float3x3 and float4x4 matrix constructors.

Bug Fixes

• BUG ID 132111 - Crop: Linked expressions within the box controls didn't evaluate the expressions correctly.

• BUG ID 145446 - Using a custom viewerProcess displayed a Bad value for colorspace error.

• BUG ID 150512 - Writing files on a render farm ignored the render_order option, resulting in Can't rename .tmp to final, File exists errors.

• BUG ID 157428 - Opening a script with an invalid viewerProcess displayed a Runtimeerror.

• BUG ID 160138 - Mirror: Adding a Mirror node to a script cropped the bounding box to the visible format, discarding overscan.

• BUG ID 161753 - Custom viewerProcesses were not ignored in terminal mode.

• BUG ID 163781 - Nuke Assist: TimeOffset nodes did not work as expected until the script was saved.

• BUG ID 169841 - Soft Effects: The BlinkScript effect did not accept parameter names containing a leading underscore.

• BUG ID 171095 - BlinkScript: Compilation error messages were not dismissed from the Viewer when the error was addressed.

• BUG ID 195996 - Read: Nuke Studio always read H264 encoded source clips using the mov64 reader.

• BUG ID 199229 - Timeline Editing: Scrubbing the playhead in sequences containing audio tracks was slow to respond.

• BUG ID 199893 - CornerPin: Expression linking controls using Tcl did not work as expected.
• BUG ID 216806 - The public **DD::Image** interface for the OCIOColorSpace node could not initialize certain values and occasionally caused Nuke to crash.

• BUG ID 221017 - Opening a script with a missing viewerProcess LUT from the terminal did not work as expected.

• BUG ID 227320 - Windows only: Increasing the **motionblur** value in Transform nodes caused Nuke to become unresponsive on machines with high thread counts.

• BUG ID 228773 - Localization: Reads did not fall back to the source files when the localized files were deleted.

• BUG ID 238700 - OFlow: Loading certain scripts containing OFlow nodes exported from Nuke Studio caused Nuke to crash.

• BUG ID 238873 - Deep: Viewing the **depth** channel in a customer script caused Nuke to crash.

• BUG ID 246196 - Deep: Processing Deep nodes was occasionally slower on NVIDIA Quadro series GPUs.

• BUG ID 246227 - Reading certain large resolution images at certain zoom levels caused Nuke to crash.

• BUG ID 253077 - macOS only: Localization did not work as expected when using **Preferences > General > path substitutions.**

• BUG ID 253451 - Monitor Output: 10-bit output from Blackmagic 4K Extreme 12G cards was not supported outside the SMPTE-range due to limitations in the current Blackmagic drivers.

• BUG ID 266300 - Create Comp: Exporting multiple shots to the same comp didn't use the correct start frame.

• BUG ID 266423 - Timeline Editing: Playing back audio in a source Viewer placed the playhead well outside the audio's timecode.

• BUG ID 270623 - Deep: Writing Deep **.exr** files with LensDistortion rendered files containing scanline errors when read back in.

• BUG ID 271069 - Node trees containing multiple Transform nodes calculating **motionblur** and expressions caused Nuke to become unresponsive.

• BUG ID 272435 - Windows only: Setting a **Comp Disk Caching > temp directory** in the **Preferences** caused Nuke to become unresponsive.

• BUG ID 273671 - Documentation: The **Documentation > Release Notes** link from Nuke's menu bar pointed to the wrong URL.

• BUG ID 274184 - Nuke's version number was incorrect in the command line.

• BUG ID 275417 - Create Comp: Exporting a single comp containing multiple clips ignored any **Custom** frame range values.

• BUG ID 275698 - macOS only: Adjusting the analysis area in a Denoise node caused Nuke to crash.

• BUG ID 275718 - Deep: Rendering a DeepWrite that referenced a DeepRead with no **file** specified caused Nuke to crash.
- BUG ID 278036 - Localization: The Cache > Localization > Force Update > Selected menu option did not work as expected.
- BUG ID 278678 - Documentation: It was not clear in the documentation that the Camera node's near clipping plane must be set to a positive value to produce sensible results.
- BUG ID 279107 - Denoise: Setting temporal processing to ≥ 4 displayed CUDA errors.
- BUG ID 279446 - LensDistortion: The 3DE Radial Fisheye preset produced splatting artifacts in Undistort mode.
- BUG ID 286596 - OCIO: Setting Project Settings > OCIO config to aces_1.0.1 reset the Viewer LUT.
- BUG ID 304710 - Linux only: Analyzing and tracking in PointCloudGenerator displayed a blank Progress dialog over the top of the working Progress dialog.
- BUG ID 304723 - Export: The Version token number field in Nuke Studio did not accept 00 as a version number.
- BUG ID 306164 - BlinkScript: The Rolling Kernel example in the documentation did not work as expected.
- BUG ID 306252 - Documentation: The ? help button for the VectorToMotion node pointed to the wrong URL.
- BUG ID 306303 - Export: The all tracks option in Nuke Studio's Export dialog included disabled tracks in the output.
- BUG ID 306614 - Channels in .exr files, other than the RGBA channel set, appeared opaque rather than premultiplied.
- BUG ID 308133 - Workspaces: Double-clicking on a comp container occasionally opened the Node Graph as a floating window.
- BUG ID 310292 - Switching shot version in the timeline using the Alt+up or down keyboard shortcuts only worked once.
- BUG ID 310512 - macOS only: Dock icons were occasionally grayed-out after closing and reopening the application.
- BUG ID 310594 - Deep: The DeepToPoints node did not generate a point cloud correctly when a Camera was connected.
- BUG ID 312397 - Wiping between two images with Use GPU for viewer when possible enabled in the Preferences, stopped the Viewer gain and gamma controls having any effect.
- BUG ID 312552 - macOS only: Opening .wav files in the Timeline View displayed a red square overlay.
- BUG ID 312944 - Clamp: Adjusting the minimum control clamped to incorrect values.
- BUG ID 312983 - Linux only: Canceling and restarting a CameraTracker progress dialog created multiple blank progress dialogs.
- BUG ID 315478 - Windows only: The Clamp node did not clamp negative values to 0.
• BUG ID 315660 - Soft Effects: Keyframes were not updating correctly in Transform effects imported from Premiere .xml timelines.

• BUG ID 316429 - Analytics: Agreeing to submit usage statistics printed user information in the terminal.

• BUG ID 316775 - PlanarTracker: Selecting a CornerPin2D track type in the control above the Viewer caused Nuke to crash.

• BUG ID 316797/321837 - Nuke and Nuke Studio printed multiple Qt errors in the terminal during normal operation, such as QPainter and QOpenGLContext.

• BUG ID 317082 - Timeline Disk Caching: The invalid cache warning displayed even when the database was empty.

• BUG ID 318107 - Timeline Editing: Muting an audio track caused pointer moves to scroll up and down in the timeline.

• BUG ID 320055 - Audio: Adding certain .mp4 encoded source clips to a sequence did not playback audio correctly.

• BUG ID 321018 - Export: Transcoding to the .tga format with the Channels control set to all did not work as expected.

• BUG ID 321222 - Undo: Changing a control's value multiple times and then undoing reverted the control to its first value, ignoring the intermediate values.

• BUG ID 321929 - Expressions: Nuke reported errors for expressions that didn't exist, rather than warnings, causing renders to exit with a return code of 1.

• BUG ID 322214 - Transform: Adjusting the shutter control with motionblur enabled inverted any rotation values.

• BUG ID 323369 - Localization: Loading a customer script caused Nuke to crash.
Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html for more information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to keep these changes to a minimum and only for certain releases, but from time to time API and ABI compatibility is not guaranteed. See the following table for the situations when you may have to recompile your plugins and/or make changes to the source code.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Example</th>
<th>Compatibility</th>
<th>Recompile</th>
<th>Rewrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>10.0v1 to 10.0v2</td>
<td>API and ABI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>10.0v1 to 10.5v1</td>
<td>API</td>
<td>![Recompile]</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td>10.0v1 to 11.0v1</td>
<td>-</td>
<td>![Recompile]</td>
<td>![Recompile]</td>
</tr>
</tbody>
</table>

Additionally, node **Class()** names occasionally change between major releases. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The **toolbars.py** file, used to create Nuke's node toolbar, contains all the current node class names and is located in `<install_directory>/plugins/nukescripts/` for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node **Class()** changed from CameraShake2 to CameraShake3. In the **toolbars.py** file for the two releases, the entries for the CameraShake node appear as follows:

```python
m.addCommand("CameraShake", "nuke.createNode("CameraShake2")", icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode("CameraShake3")", icon="CameraShake.png")
```

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
Bug Fixes

- BUG ID 247793 - Python: The `<install_dir>/pythonextensions/site-packages/hiero/ui/init_.py` file referred to `hiero.core.rawArgs` incorrectly.
- BUG ID 314080 - Python: Calling `nuke.clone(nuke.selectedNode(), inpanel=False)` ignored the `inpanel` flag and created a new panel.
- BUG ID 322312 - Building Qt 5.6.1 from the package on Foundry.com did not work as expected.